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Systems to clarify macOS.

October 1, 2021 Added MCCET-4191 and MCCET-4725 to Fixed in Media Composer
v2021.9

IMPORTANT: Avid periodically makes software updates available for download on
Avid.com at the following location:www.avid.com/us/support/downloads. Please
check the above site regularly for information on available downloads for your
product.

Important Information

Avid® recommends that you read all the information in this ReadMe file thoroughly before
installing or using any new software release.

Important: Search the Avid Knowledge Base for the most up-to-date ReadMe file, which
contains the latest information that might have become available after the documentation was
published.

This document describes compatibility issues with previous releases, software installation
instructions, hardware and software requirements, and summary information on system and
memory requirements. This document also lists hardware and software limitations.
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Symbols and Conventions

Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

A note provides important related information, reminders, recommendations, and
strong suggestions.

A caution means that a specific action you take could cause harm to your
computer or cause you to lose data.

> b I

A warning describes an action that could cause you physical harm. Follow the
guidelines in this document or on the unit itself when handling electrical
equipment.

A user tip provides a helpful hint that can aid users in getting the most from their
system.

m

A shortcut shows the user keyboard or mouse shortcuts for a procedure or
command.

m



If You Need Help

Symbol or Convention Meaning or Action

>

(Windows), (Windows
only), (macOS), or (macOS
only)

Bold font

Italic font
Courier Bold font

Ctrl+key or mouse action

| (pipe character)

This symbol indicates menu commands (and subcommands) in the order you
select them. For example, File > Import means to open the File menu and then
select the Import command.

This symbol indicates a single-step procedure. Multiple arrows in a list indicate
that you perform one of the actions listed.

This text indicates that the information applies only to the specified operating
system, either Windows or macOS.

Bold font is primarily used in task instructions to identify user interface items and
keyboard sequences.

Italic font is used to emphasize certain words and to indicate variables.
Courier Bold font identifies text that you type.

Press and hold the first key while you press the last key or perform the mouse
action. For example, Command+Option+C or Ctrl-+drag.

The pipe character is used in some Avid product names, such as MediaCentral |
Production Management. In this document, the pipe is used in product names
when they are in headings or at their first use in text.

If You Need Help

If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It is
especially important to check each step of your workflow.

2. Check this ReadMe file for the latest information that might have become available after the
documentation was published. Also check online for the most up-to-date ReadMe because
the online version is updated whenever new information becomes available. To view the
online ReadMe, select ReadMe from the Help menu, or visit the Knowledge Base at
http://www.avid.com/readme.

3. Check the documentation that came with your Avid application or your hardware for
maintenance or hardware-related issues. In addition to the printed documentation supplied
with your editing application, the documentation is supplied in PDF format when you install
the application. Topics that you print from the Help have limited page layout and formatting
features. If you want to print a higher quality version of Help information, Avid recommends


http://avid.force.com/pkb/articles/en_US/readme/Media-Composer-Software-8-0-Documentation

If You Need Help

that you print all or part of the PDF version of the appropriate Avid manual included in the
Online Library for your editing application. To access the Online Library, select Help >
Online Library from within your Avid editing application.

. Visit Avid Online Support at www.avid.com/onlineSupport/. Online support is available 24

hours per day, 7 days per week. Search the Knowledge Base to find answers, to view error
messages, to access troubleshooting tips, to download updates, and to read or join online
message-board discussions.

Media Composer Notes

(mac Only) macOS Catalina does not support 32 bit applications. The legacy Title Tool,
Marquee Title Tool and QuickTime legacy codecs are no longer installed when you install
Media Composer. If you are installing Media Composer on a system with a pre-Catalina
OS, a separate installer is provided that allows you to choose to install the Title Tool,
Marquee, and QuickTime legacy codecs. Only install legacy codecs if QuickTime is
installed on your system. The installer is Media Composer Legacy Components 2021.12.1
Mac. You can get the installer from MyAvid, Link, or the download center.

& MCDEV-11537 If you intend to use full-frame stereoscopic with an Avid Artist DNxIQ, you
may want to remain with Media Composer v2018.12.x until the issues with Stereoscopic
support are resolved in a future version.

& (Mac) You might receive an “Is not optimized for your Mac” message while launching
Media Composer for the first time on a Mac OS 10.14.x system. Press OK to continue.

(MCCET- 2541) When working with Avid Artist DNXIO or Avid Artist DNxIQ, you should
disable the Line In recording input (BlackMagic Audio in the Windows OS).

Avid recommends that you do not install Desktop Video software version 10.10.1 on Media
Composer versions prior to v2018.5.1.

Avid Artist DNxIO and Avid Artist DNxIQ: If you are using Avid Artist DNxIO, Avid
Artist DNxIQ, or a BlackMagic Designs video device, please update to Desktop Video
software version v11.0 or higher. If you are using Avid Artist DNxIV and Avid Artist DNxIP
please update to AJA software v15.2 or later.

Qualified Operating Systems: For information on qualified operating systems, see
Qualified Hardware and Operating Systems.

Dongle Info (Mac Only): The Dongle Sentinel driver installer is no longer automatically
installed when you install the editing application. The driver is now located in the
Avid_Utilities folder (/Applications/Utilities/Avid_Ultilities/Sentinel_Driver). If you have a
dongle, manually install the driver from this location.


http://www.avid.com/onlinesupport

If You Need Help

When installing the Sentinel Driver, check your System Preferences and select “Security
and Privacy.” You may need to choose to Allow the driver to be accessed.

*  Media Composer now includes a dnxmov2mxf executable in the \Program Files\Avid\Avid
Media Composer\SupportingFiles\Utilities folder. This executable allows you to manually
convert MOV files with DNX essence with separately stored alpha to an MXF OP1a file
with DNX essence and embedded alpha.

The tool is available for Windows, 0sX and Linux. To run on Windows, Visual C++
Redistributable for Visual Studio 2015 or Visual C++ Redistributable for Visual Studio 2017
is required.

Run the command from a command prompt on Windows or from terminal on macOS.
DNXMOV2MXF usage is:

dnxmov2mxf path_to_mov [path_to_mxf]

Security Guidelines

As system and network security attacks become increasingly more inventive and persistent, Avid
has adopted a new security strategy to help you, our customer and partner, better protect your
assets and intellectual property. As you might know, Avid has traditionally recommended
Symantec Endpoint Protection as the preferred and qualified solution for much of the Avid
product line. As of Q3, 2020, Avid introduced a more flexible strategy that provides general
guidelines for protecting your Avid systems. This new policy allows you to choose the best
security solution for your organization, while still following Avid best practices. Avid Media
Composer allows you to install an endpoint detection and response solution on your
system.While Avid does not support any specific solution, you can find general guidelines and
information related to CrowdStrike Falcon on the following Avid Knowledge Base page:

https://avid.secure.force.com/pkb/articles/en_US/troubleshooting/en239659


https://avid.secure.force.com/pkb/articles/en_US/troubleshooting/en239659

Changed in Media Composer v2021.9

Changed in Media Composer v2021.9

The following have changed with Media Composer v2021.9:

Clear Bin Memory Button Location Change

The Clear Bin Memory button is located on the Configuration tab of the About Media Composer
menu. You can access About Media Composer from the Help menu.




Changed in Media Composer v2021.9

Updated Message

The editing application notifies you if your third party storage is emulating Avid NEXIS or Avid
ISIS storage. With this release, the error message has been updated:

In addition, this message appears:

*  When you install an updated version of Media Composer, even if you have seen the message
before.

*  When you open a shared project on any system.

*  When you open a new project created on any system

Default Change for Bin Frame View
With this release, you will notice the following: If clips have an assigned clip color, the color will

appear as a border on clips in Frame View by default. You will see this change if you create a
new user setting after installing Media Composer v2021.9.

(macOS) No Restart after Install

With this release, if you are on a macOS system, you do not have to restart after installing Media
Composer.

macOS

See the latest macOS versions supported in Qualified Hardware and Operating Systems.



Changed in Media Composer v2021.9

Move Clip Leaves Filler

=

You can use an option in the Timeline menu that allows you to leave filler when you move clips
up and down over multiple tracks in a sequence. When you select the Move Clip Leaves Filler
option in the Timeline menu, a check mark appears next to the option indicating it is enabled.
When you do not want to leave filler, simply select the Move Clip Leaves Filler option again to
remove the check mark.

Tirmeline Compoaoser Tools W

Add Filler

Eender

Restare Default Patch

Change Source Track

« Mowve Clip Leaves Filler

You can easily map this command to your keyboard. See “Mapping Menu Commands” in the
Help.



Fixed in Media Composer v2021.9

Improved Bin Column Width Adjustments

Bin Column widths can now be manually adjusted. Simply drag the separator between column
headers to resize the column. The bin width is saved when you save or close the bin. You can
also double-click on the separator between columns to resize the entire column, not just the
visible area.

Some non-text columns such as Frame or Color are fixed and cannot be manually adjusted.

Fixed in Media Composer v2021.9

>

Bug Number: MCCET-4275. Opening large sequences containing SubCap effects crashed
Media Composer.

Bug Number: MCCET-4191. The TRK bin column heading was changed to lowercase Trk for
imported ALE files, which did not pass the track data via AAF to Pro Tools.

Bug Number: MCCET-4202. You may have received a “writing properties to asset manager”
error when checking in a Matte key clip.

Bug Number: MCCET-4218. In some instances, QuickTime with alpha MOV files appear
offline after import.

Bug Number: MCCET-3119. Some Avid Titler+ font names may have displayed as “Invalidate
label encoding” in the Effect Editor window.

Bug Number: MCCET-4164. (macOS) Avid Titler+ English alphabet characters were left
behind once you selected Chinese Pinyin characters.

Bug Number: MCCET-4177. In some instances, media was offline in the Timeline on some of
the clips and adjusting Dynamic Relink would not bring it online.

Bug Number: MCCET-4188. (Production Management) XDCAM HD media was offline after
checkout and you could not get the media online.

Bug Number: MCCET-4305. Using Quick Find in the Timeline might have crashed Media
Composer.

Bug Number: MCCET-3893. (macOS v10.15.x) In some instances, previously saved Export
Settings were not saved properly.



Fixed in Media Composer v2021.9

Bug Number: MCCET-4296. After closing and opening Media Composer, some docked and
tabbed windows were not retained.

Bug Number: MCCET-4280. In some instances, working in the Audio Mixer crashed Media
Composer.

Bug Number: MCCET-4091. UHD 100p projects might create a duplicate timecode frame in a
25 fps Timebase.

Bug Number: MCCET-4187. Segment buttons from (Command Palette - Edit) did not work the
same as the Segment buttons from (Command Palette - Smart Tools).

Bug Number: MCCET-4183. In some instances, the User Interface would appear to freeze or
hang if you were working with a large project with many bins.

Bug Number: MCDEV-15040. You might have received an “AAF import” when performing an
update from Production Management for a sequence containing an Avid Titler+ effect.

Bug Number: MCCET-4114. Dragging a saved Audio Track Effect from a bin to the Audio
Mixer [+] did not apply the effect.

Bug Number: MCCET-3705. (Production Management) Video track name changes might not
have saved properly during check in/check out.

Bug Number: MCCET-4065. In some instances, the clip color changed on transcoded clips
with alpha.

Bug Number: MCCET-4159. In some instances, with Dynamic Relink enabled, a sequence
showed different clips offline depending on the version of Media Composer.

Bug Number: MCCET-4167. (Japanese OS) Dragging an effect from the Effects Palette moved
the highlighted effect category up unexpectedly.

Bug Number: MCCET-4079. Site settings for Media Creation were not working for some
codecs.

Bug Number: MCCET-3847, MCCET-4155. Default Media Creation settings for new projects
and when switching to a different project format might have been incorrect.

Bug Number: MCCET-3510. Even after changing the Media Creation setting, video resolution
reverted to default in 1080p50 projects.
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Fixed in Media Composer v2021.9

Bug Number: MCCET-4100. Media Creation Settings defaulted to H.264 800kbps proxy in
1080p/24 projects.

Bug Number: MCCET-4013. If the RED AMA plug-in was installed on an Edit on Demand
system, Scriptsync did not display script marks.

Bug Number: MCCET-4137. A .transfer sequence did not play in MediaCentral | UX if stereo
was enabled in the Transfer Settings.

Bug Number: MCCET-4198. You might have had problems importing/linking DNxHR HQX
media.

Bug Number: MCCET-4063. In some instances, mixing DNxHD SQ media created by EVS,
Media Director or Fastserve displayed in the bin as mixed resolution.

Bug Number: MCCET-3842. Desktop Play Delay resulted in an
“ADM_PLAY_NOT_ARMED?” error when hitting play with NDI enabled.

Bug Number: MCCET-4032. (Production Management) If you deleted a clip in Access, the
media would not display as offline, instead you would receive a “Disk File Not Found” error.

Bug Number: MCCET-4080. The Tool Palette window did not retain its size.

Bug Number: MCCET-4052. Some H265 (HEVC) files could not be linked or imported
successfully.

Bug Number: MCCET-4201. When reopening a project, the Avid MediaCentral | UX panel
opens on top of the Media Composer UL

Bug Number: MCCET-4200. The List Tool did not recall custom presets properly.

Bug Number: MCCET-4227. The Timecode Burn-In effect did not display properly when
changing the Timecode display setting.

Bug Number: MCCET-3903. You might have received a
“PMM_MISMATCH_UNKNOWN_ATTR?” error when trying to capture from SD DV through
1394 (firewire).

Bug Number: MCCET-4005. If waveforms were enabled, six hour captures of “In progress”
(EWC) clips were extremely slow.

Bug Number: MCCET-4264. You might have seen a Waveform Engine crash when opening a
bin, closing a bin, loading a sequence, or clearing a sequence.
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Fixed in Media Composer v2021.9

Bug Number: MCCET-4195. Capitalized names were sorted first regardless of alphabetical
order in the Project window.

Bug Number: MCCET-4240. In some instances, Telestream Live Capture was offline for V1,
Al.

Bug Number: MCCET-4224. In some instances, the Source Browser was not maximized
enough to display the Link and Import buttons.

Bug Number: MCCET-4029. The FrameFlex size slider did not go beyond 100% in the
FrameFlex top viewer.

Bug Number: MCCET-3997. Window position was not saved in Workspaces.

Bug Number: MCCET-4169. You may not have received a warning message when exporting
XDCAM HD 50 (RDD9) exceeding 8 audio tracks.

Bug Number: MCCET-4203. Apple ProRes 422 clips with 16bit PCM audio could not be
linked using the UME plug-in.

Bug Number: MCCET-4011. You were unable to link to ProRes 422HQ QT movie with UME
plug-in, but could link with QuickTime plug-in.

Bug Number: MCCET-3861. You could not successfully link or import ProRes HQ files
recorded with Odyssey™ by Convergent Design.

Bug Number: MCCET-3952. In some instances, mp4 files were out of sync.

Bug Number: MCCET-4292. You might have seen redraw issues in the Source monitor when
viewing 4 and 9 way MultiCam with NDI enabled.

Bug Number: MCCET-3972. Performing a Long-GOP Send to Playback to FastServe failed if a
local Transfer Engine was running.

Bug Number: MCCET-4266. In some instances, after performing a Send To Playback, the Data
track was stripped from the .transfer sequence.

Bug Number: MCCET-4182. In some instances, 3D CLF LUTs did not always get applied in
Media Composer.

Bug Number: MCCET-4226. After performing a transcode and checkout, png files might have
been offline.
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Limitations

»  Bug Number: MCCET-4238. Media Composer crashed with an “Exception: Structured
Exception” error when trying to transcode or consolidate certain clips.

»  Bug Number: MCCET-4205. AAF: Consolidating media set the master clip Start Time to Mark
In Time when asking for handles.

»  Bug Number: MCCET-4274. Moving bins and folders in a project may have resulted in a crash.

»  Bug Number: MCCET-4229. You might have received an “Exception:
MXF_DIDMapperSegmented::ReadRange” error when linking IMX50 media.

Limitations

The following are known limitations
*  Photoshop PSD files are not supported for AMA linking if QuickTime is not installed.

«  Some fonts, by their design, are available only in Bold. On the Mac system it can happen
that selecting a font does not produce any visual changes. Try selecting “Bold.”

* Ifyou launch a project and receive an “Enable 3rd Party Emulation” warning, even if you
select Enable in the warning dialog, you should also perform the following: Select File >
Settings and click the Project tab. Click General Settings and select “Enable Bin Sharing on
3rd party storage emulating Avid NEXIS/ISIS.”

»  Bug Number: MCDEV-15491. Right clicking on an empty cell in the Tool Palette results in a
crash.

»  Bug Number: MCDEV-14845. Media Composer | Enterprise Admin tool does not restrict NDI
when Media Composer is in software only mode.

»  Bug Number: MCCET-3702. Image Quality when adding UHD progressive clips to an HD
interlace sequence:

The process Media Composer uses to mix and match video formats in a sequence is to transform
the source clip's frame rate and frame layout to meet the project specifications; the motion
adapters are added first, then spatial adapters are applied in order to provide expected playback
dimensions.

For example, if you have a UHD 50p clip that you want to add to a 10801 Timeline, the UHD clip
first gets split into 2 separate fields (UHD format), then each field gets independently resized to
1920x540 in HD. The export process puts those resized fields back together into a progressive
HD frame but does not maintain the clarity of the original progressive frame.
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Limitations

Workaround: If you first transcode the UHD progressive clip to HD progressive and then add
the HD clip to the interlace sequence, it forces the resize operation from UHD to HD to be done
before the split gets into interlace mode.

Bug Number: MCCET-3788. You might receive a “clip name is a clip in a multi-essence file
that cannot be exported using the specified Embedded in AAF setting” when exporting
embedded AAFs with OP1a audio clips.

Workaround: Consolidate the OP1a clips to Avid OP-Atom prior to performing the export.

Bug Number: APPSVCS-723. The Collab App in MediaCentral CloudUX window does not
currently work with Media Composer.

Bug Number: MCDEV-13604. You might have issues playing clips containing Media
Composer effects in the Baselight User Interface if the Fast Image Access option is enabled in
the Baselight plug-in

Bug Number: MCDEV-12926. (macOS) If you have upgraded to macOS 10.15.4, there is a
known issue with local attached RAID storage. The system will hang when running Media
Composer or copying large files. This does not happen with earlier versions of the OS. You can
read details about this issue in this blog. This limitation no longer exists with macOS 10.15.5.

Bug Number: MCDEV-12988. (macOS) The AMA Drastic plug-in is not supported with Media
Composer v2020.4

Bug Number: MCDEV-12964. For a faster performance of export audio/video sequences to
.mov in 2020.4, please render the sequence prior to export, or disable the GPU fx (in the Render
Settings - Current menu)

Bug Number: MCDEV-12735. Maestro graphics do not appear correctly in the Timeline if your
system uses the Radeon video card.

Bug Number: DEFI-1808. (Media Composer | Distributed Processing) Two clips or sequences
will always be created when performing a consolidate or transcode with Media Composer |
Distributed Processing.

Bug Number: MCDEV-11481. Promoting a title from the Title Tool application to Avid Titler+
cannot be performed if it includes a motion adapter.

Bug Number: MCCET-11796. Larger than 10 bit DPX files might fail to link correctly.

Workaround: Go to File > Settings and click the User tab. In the Link Settings, click the Link
Options tab and make sure Alpha Channel is set to Ignore.
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Limitations

Bug Number: MCDEV-11430. Media Tool ignores the “Current project” filtering option and
lists media files that are not associated with the current project.

Bug Number: MCDEV-11197. In some instances, the Interleave option might not appear in the
Export As dialog box. If you are performing an Export using the Avid Media Processor, the
Interleave option should appear when you choose Stereo, 5:1, or 7.1 Audio.

Workaround: If it does not appear, briefly toggle back to the Mono setting, then toggle to
Stereo Mix once again. Doing so should reveal the Interleave option.

Bug Number: MCDEV-8641. (AMD Graphics). Systems with AMD graphics cards might
display tearing when performing Full Screen playback.

Bug Number: MCDEV-9269. (Media Composer | Cloud) After performing a remote download
operation on a sequence containing AVC-I 100 remote media, the downloaded media appears as
XAVC-I 100.

Workaround: Download the entire master clips.

Bug Number: (macOS). You may occasionally see the menu bar flash followed by a brief
beach ball. To fix this, deactivate “Displays have separate spaces” under System Preferences >
Mission Control settings.

Bug Number: MCDEV-9011. Intermittently, when working with the XDCAM Nablet Plug-in,
you might see “Failed to get the sample position from the AMA Plug-in” errors if you have
waveforms enabled in the Timeline.

Bug Number: COGS-2560. While working in the Script Window, text operations
(cut/copy/paste/delete/editing) can only be done in edit mode. See “Editing a Script” in the Help.

Bug Number: MCDEV-5650. When working with Panasonic LongG media, you might receive
an “SFPlayConsumer Timeout” error if audio waveforms are enabled.

Workaround: Turn off audio waveforms.

Bug Number: MCDEV-5385. MultiCam editing with Panasonic LongG media is not supported
with this release.
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Before Installing the Editing Application

Before Installing the Editing Application

Media Composer | Enterprise and Media Composer | Distributed Processing

If you are working with Media Composer | Enterprise or Media Composer | Distributed
Processing, please refer to the “Installation Prerequisites” section in the Media Composer |
Enterprise Administration Guide and Media Composer | Distributed Processing Administration
Guide to make sure you have compatible Avid MediaCentral Cloud UX Platform ISO and Avid
MediaCentral Cloud UX Feature Pack ISO versions.

Avid DX Driver Separate Installer

The Avid DX Driver is not automatically installed when you install the editing application. If
you need to install the Avid DX Driver to work with your Avid IO device, you can install it
separately.

The installer is located:

*  (Mac) /Applications/Utilities/Avid Utilities

*  (Windows) Program Files\Avid\Utilities\DXDrivers

Before Installing the Editing Application in an Avid Interplay Environment

& Please note the following before you install the editing application in an Avid Interplay or
Avid MediaCentral environment.

Carefully read through the “Avid Editor Compatibility with Interplay Releases” guide (found in
the following link) before upgrading. It might be necessary to also upgrade the Interplay
components on the editing client.
http://avid.force.com/pkb/articles/en_US/compatibility/Avid-Video-Compatibility-Charts

Buffer Error Message

The editing application requires a minimum of 8GB RAM. If you try to install the editing
application on a system with less than 8§GB RAM, you will receive a buffer error and installation
will not proceed.

Download Note

To avoid “File Path too long” or a “File cannot be copied” warning while unzipping the
downloaded installer, try placing the installer .zip on the root level of your C:\ drive and unzip it
from that location.
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After Installing the Editing Application

User Right to Raise Thread Priority

(Windows) Note for Domain Administrators: If your editing systems are part of a domain, you
must give the user the right to “Increase Scheduling Priority.” This must be done within the
Domain Group Policy on the domain controller by giving the right explicitly to the user or giving
the right to a group and adding the user to that group. You will not be able to launch as a regular
user if this is not set properly.

If you are part of a domain, a Domain Administrator should install and perform the first launch
of the editing application.

Install as Administrator

You need to first install and launch the editing application as an Administrator. If you are in a
Shared Storage environment, mount your workspaces as an Administrator. You may then log off
and log back in as a Standard user, if necessary.

After Installing the Editing Application

AMA Plug-Ins

You cannot install the AMA Plug-ins while the editing application background services are
running. Make sure you Stop the services before installing the AMA Plug-Ins. The stop/start
background services icon is on the menu bar (Macintosh) or taskbar (Windows). Once you install
the new AMA plug-in, restart the services. See “Starting and Stopping Avid Background
Services” in the Help.

Notes on Software Licensing

If You Upgrade Your Operating System

If you need to upgrade your operating system after you install your Avid editing application, first
deactivate your software. After you upgrade your operating system and, if required, reinstall
your application, you can reactivate your software. For information on activating and
deactivating your software license, see the Installation Guide for Avid Editing Applications.

Minimum RAM Recommendation

For this release Avid recommends 16 GB minimum, 32 GB recommended. Some features might
require more RAM and specific hardware. See “Feature Performance” on page 37 for more info.
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Qualified Hardware and Operating Systems

Qualified Hardware and Operating Systems

Some features are processor-intensive and require specific hardware. See “Feature Performance”
on page 37 for more info.

The following tables provide the information on qualified Windows and Macintosh hardware.

For 3rd-Party Open 10 hardware qualification refer to the manufacturer’s documentation. See the
Open 10 Frequently Asked Questions document on the Knowledge Base:
http://avid.force.com/pkb/articles/en_US/faq/en422991

The following lists the qualified Operating Systems. Depending upon your hardware the
qualified Operating Systems are:

*  Windows v10 64-bit v 2004 or later (Professional and Enterprise).
e Macintosh 10.14.6, 10.15.7, 11.x up to 11.5.x

With the release of Mac OS v10.13.x and higher, Apple requires manual approval of loading
Kernel Extensions (KEXTs). (For example BlackMagic, and AJA 10 devices install Kernel
Extensions.) At installation time, you should get a dialog saying that the KEXT was not loaded.
You must go the “Security & Privacy” system preference and manually approve the KEXT. Keep
the Security & Privacy pane open after you install the I/O device drivers so that you will see the
notice that the driver has been blocked and press the “allow” button within 30 minutes of
installing or the driver will be permanently blocked.

Qualified Workstations and Laptops

The following tables list the qualified workstations and laptops for Media Composer editing
applications.

NOTE: NVIDIA drivers are not included with the Media Composer installer. You must access
the Nvidia website - Nvidia.com to download the applicable driver.

NOTE: AMD drivers are not included with the Media Composer installer. You must access the
AMD website - AMD.com to download the applicable driver.

Qualified PC Workstations with Avid Media Composer

The following PC Workstations are qualified with Avid Media Composer.

Avid Artist DNxIV requires a Thunderbolt 2 or 3 card. See details here.
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Qualified Hardware and Operating Systems

Qualified PC Hardware Graphics Card  Supported with
HP Z2 G8 2.8 Ghz or higher 6, 8 core 17/19 Xeon Nvidia T600, Avid Artist DNxIO
Intel 11th Gen Tower or SFF T1000, RTX Avid Artist DNxIQ
A2000, A4000 Avid Artist DNxIV

AMD W5500, Avid Artist DNXID

WS5700 Avid Artist DNXIP

HP Z4R 3.0 Ghz or higher 6 to 18 core XEON  Nvidia P1000, Avid Artist DNxIO
1U Rack system P2200, RTX 4000, Avid Artist DNxIQ
5000, 6000 Avid Artist DNxIV

Avid Artist DNxID

Avid Artist DNxIP

HP Z2 G5 2.8 Ghz or higher 6, 8, or 10 core Nvidia P620, Avid Artist DNxIO
17/19/Xeon Tower or SFF P1000, P2200, RTX Avid Artist DNxIQ
16 to 128 GB DDR4-2933 memory 4000 Avid Artist DNxIV
AMD W5500, Avid Artist DNXID

W5700 Avid Artist DNxIP

HP Z2 G5 Mini 3.0 Ghz or higher 6, 8, or 10 Nvidia P620, Avid Artist DNXIO
core 17/19/Xeon T1000, T2000 Avid Artist DNxIQ
16 to 64 GB DDR4-2933 Memory. Avid Artist DNxIV
Avid Artist DNxID

Avid Artist DNxIP

Dell 3640 2.8 Ghz or higher 6, 8 or 10 core Nvidia P620, Avid Artist DNxIO
17/19/Xeon Tower P1000, P2200, RTX Avid Artist DNxIQ
16 to 128 GB DDR4-2933 memory 4000 Avid Artist DNxIV
AMD W5500, Avid Artist DNxID

W5700 Avid Artist DNxIP

Dell 3440 2.8 Ghz or higher 6, 8 or 10 core Nvidia P620 P1000 Avid Artist DNxIO
i7/19/Xeon SFF Avid Artist DNxIQ
16 to 128 GB DDR4-2933 memory Avid Artist DNxIV
Avid Artist DNxID

Avid Artist DNxIP

Lenovo P340 2.8 Ghz or higher 6, 8 or 10 core  Nvidia P620 P1000 Avid Artist DNxIO
17/19/Xeon Tower or SFF P2200, RTX 4000  Avid Artist DNxIQ
16 to 128 GB DDR4-2933 memory Avid Artist DNxIV
Avid Artist DNxID

Avid Artist DNxIP
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Qualified Hardware and Operating Systems

Qualified PC Hardware Graphics Card  Supported with
Lenovo P340 Tiny 2.8 Ghz 6 or 8 core i7/i9 Nvidia P620 P1000 Avid Artist DNxIO
16 to 64 GB DDR4-2933 memory Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Lenovo P620 12-64 core 2.7 Ghz or higher Nvidia RTX 4000, Avid Artist DNxIO
AMD Threadripper Pro 5000, 6000 Avid Artist DNxIQ

32 to 256 GB DDR4-3200 Memory AMD W5500, Av%d Art%st DNxIV
W5700 Avid Artist DNxID

Avid Artist DNxIP

Boxx ApexxT4 32 core 3.7 Ghz or 64 core 2.9  Nvidia RTX 5000  Avid Artist DNxIO
Ghz AMD Threadripper AMD W5700 Avid Artist DNxIQ
32 to 256 GB DDR4-3200 Memory AMD Pro VII Avid Artist DNxIV
Thunderbolt 3 option Avid Artist DNxID
Avid Artist DNxIP

HP Z2 G4 3.0 Ghz or higher six core i7/Xeon E3 Nvidia P620, Avid Artist DNxIO
Tower or SFF P1000, P2000 AMD Avid Artist DNxIQ
16 to 64 GB DDR4-2666 memory WX7100 Avid Artist DNxIV
Avid Artist DNxID

Avid Artist DNxIP

Dell 3630 3.0 Ghz or higher six core i7/Xeon E3 Nvidia P1000, Avid Artist DNxIO
Tower 16 to 64 GB DDR4-2666 memory P2000 AMD Avid Artist DNxIQ
WX7100 Avid Artist DNxIV

Avid Artist DNxID

Avid Artist DNxIP

Dell 3430 3.0 Ghz or higher 6-8 core i7/Xeon E3 Nvidia P620, P1000 Avid Artist DNxIO
SFF 16 to 64 GB DDR4-2666 memory Avid Artist DNxIQ
AMD WX4100 Avid Artist DNxIV

Avid Artist DNxID

Avid Artist DNxIP

Dell 3930 3.0 Ghz or higher six core i7/Xeon E3  Nvidia P1000, Avid Artist DNxIO
1U Rack 16 to 64 GB DDR4-2666 memory P2000, P2200 AMD Avid Artist DNXIQ
WX7100 Avid Artist DNxIV

Avid Artist DNxID

Avid Artist DNxIP
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Qualified PC Hardware

Qualified Hardware and Operating Systems

Graphics Card

Supported with

Lenovo P330 3.0 Ghz or higher 6 or 8 core
i7/Xeon E3 Tower or SFF 16 to 64 GB
DDR4-2666 memory

Lenovo P330 Tiny 2.4Ghz 6-8 core 17/i9
16 to 64 GB DDR4-2666 memorys

HP Z2 G4 Mini 3.0 Ghz or higher six core
i7/Xeon E3

16 to 32 GB 2666Mhz DDR4 Memory.
Performance model only Thunderbolt option.

HP Z8 G4 Dual [8 - 24 core 2.1 Ghz or higher]
scalable

64-128 GB DDR4-2666 memory, Tower

HP Z6 G4 Dual [8 -24 core 2.1 Ghz or higher]
Intel Scalable Processors
64 to 192 GB DDR4-2666 memory

HP Z4 G4 6 - 10 core or 18 core 2.3 Ghz or
higher processor

32-128 GB DDR4-22xx memory

Dell 7920 Dual (8-24 core 2.1 GHz or higher)
Intel Scalable Processors Tower
64 to 128 GB DDR4-2666 memory

21

Nvidia P600 P1000
P2000

Nvidia P600, P620,
P1000

Nvidia P600, P1000
AMD WX7100

Nvidia P4000,
P5000, P6000,
RTX4000
AMD WX7100,
WX9100

Nvidia P2000,
P4000, P5000, RTX
4000, 5000
AMDWX7100

Nvidia P1000,
P2200, P4000

RTX 4000
AMD WX7100

Nvidia P4000
P5000 P6000
AMD WX7100

Avid Artist DNXIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNXID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP



Qualified PC Hardware

Qualified Hardware and Operating Systems

Graphics Card

Supported with

Dell R7920 Dual (8-24 core 2.1 GHz or higher)
Intel Scalable Processors Rack

64 to 128 GB DDR4-2666 memory
Thunderbolt adapter not supported in Rack 7920

Dell 7820 Dual (8-24 core 2.1 GHz or higher)
Intel Scalable Processors
64 to 128 GB DDR4-2666 memory

Dell 5820 6-18 core 2.3 Ghz or higher
Intel Xeon W2-2xx Core i7/i9
32 to 128GB DDR4-2666 memory

Lenovo P920 Dual [8 -28 core 2.1 Ghz or
higher] Intel Scalable Processors
64 to 192 GB DDR4-2666 memory

HP Z1 G3 All-in-one 3 3.4 Ghz or higher quad
core i7/Xeon E3
16 to 64 GB DDR4-2133 memory

HP Z240 3.0 Ghz or higher quad core i7/Xeon
E3 64 GB DDR4-2400 memory Tower or SFF

HP Z2 Mini 3.0 Ghz or higher quad core
i7/Xeon E3 16 to 32 GB 2400Mhz DDR4
Memory, USB-C

Dell 3620 3.0 Ghz or higher quad core i7/Xeon
E3 16/32 GB DDR4-2400 memory Tower

Dell 3420 3.0 Ghz or higher quad core i7/Xeon
E3 16/32 GB DDR4-2400 memory SFF
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Nvidia P4000
P5000 P6000
AMD WX7100

Nvidia P2000,
P4000 P5000
RTX 4000, 5000
AMD WX7100

Nvidia P1000,
P2200, P4000
AMD WX5100,
7100

Nvidia P4000
P5000, P6000

Nvidia M1000M,
M2000M

Nvidia P600, P100,
P2000

Nvidia M620

Nvidia M2000,
M4000

P600, P1000

Nvidia K620,
K1200

P600, P1000

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Software Only

Software Only

Software Only

Software Only



Qualified PC Hardware

Qualified Hardware and Operating Systems

Graphics Card

Supported with

Dell 5720 AIO 3.3 Ghz or higher quad core
i7/Xeon E3 3840x2160 - 16 to 64 GB 2400Mhz
DDR4 Memory, thunderbolt 3/USB-C

Lenovo P720 Dual [8 -28 core 2.1 Ghz or
higher] Intel Scalable Processors
64 to 192 GB DDR4-2666 memory

Lenovo P520C 6, 8, 10 or 18core 2.3 Ghz or
higher] Intel W-Processors
32 to 128 GB DDR4-2666 memory

Lenovo P320 3.0 Ghz or higher quad core
i7/Xeon E3 16/32 GB DDR4-2400 memory
Tower or SFF

Lenovo P320 Tiny 2.9 GHz quad core i7-7700T

HP Z840 Dual [8 - 16 core 2.1 Ghz or higher]
Intel V4 32/64 GB DDR4 2400 memory

HP 7640 Dual 10, 12, 16 core 2.1 Ghz or
higher] Intel V4 32/64 GB DDR4-2400 memory

Dell 7910 Dual [8 - 16 core 2.1 Ghz or higher]
Intel V4 32/64 GB DDR4-2400 memory
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AMD WX4150,
WX7100

NvidiaP2000,
P4000 P5000
RTX 4000, 5000

Nvidia P1000,
P2200 P4000
RTX 4000

Nvidia P600,
P1000,
P2000(Tower)

Nvidia P600

Nvidia P4000,
P5000, P6000,
M4000, M5000,
M6000

AMD W7100,
WX7100

Nvidia P4000,
P5000, P6000
M2000, M4000
M5000, M6000

AMDW5100,
W7100, W8100

Nvidia M4000,
M5000, M6000

AMD W7100,
W8100

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxID
Avid Artist DNxIP

Software Only

Software Only

Avid Artist DNxXIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP



Qualified PC Hardware

Qualified Hardware and Operating Systems

Graphics Card

Supported with

Dell R7910 Dual [8 - 16 core 2.1 Ghz or higher]
Intel V4 32/64 GB DDR4-2400 memory

Dell 7810 Dual [8-16 core 2.1 Ghz or higher]
Intel V4 32/64 GB DDR4-2400 memory

Dell 5810 [6 or 8 core 3.0 Ghz or higher] Intel

V4 16/32/64 GB DDR4- 2400 memory

Lenovo P910 Dual [8 - 16 core 2.1 Ghz or
higher] Intel V4 32/64 GB DDR4-2400 memory

Lenovo P710 Dual [8 - 16 core 2.1 Ghz or
higher] Intel V4 32/64 GB DDR4-2400 memory

HP Z440 [4 or 8 core 3.0 Ghz or higher] Intel

V4 16/32/64 GB DDR4- 2400 memory

Lenovo P510 6 or § core 3.0 Ghz or higher Intel

V4 16/32/64 GB DDR4- 2400 memory

Lenovo P410 6 or § core 3.0 Ghz or higher Intel

V4 16/32/64 GB DDR4- 2400 memory

HP Z840 Dual 8, 10 or 12 core Intel V3 2.3 Ghz
or higher Onboard NIC supported for ISIS 32 or

64 GB DDR4- 2133 memory
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Nvidia M4000,
M5000, M6000

AMD W7100,
W8100

Nvidia M2000,
M4000, M5000

AMD W5100W,
W7100, W8100

Nvidia M2000
AMD W5100

Nvidia M4000,
M5000, M6000

Nvidia M2000,
M4000, M5000

Nvidia PK2200
AMD W5100

Nvidia P2000,
M2000, K2200

Nvidia P2000,
P1000
M2000, K1200

Nvidia K4200,
K5200, M4000,
M5000, M6000

AMD W7100,
W8100

Avid Artist DNXIO
Avid Artist DNxIQ

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP



Qualified PC Hardware

Qualified Hardware and Operating Systems

Graphics Card

Supported with

HP Z640 Dual 8, 10 or 12 core Intel V3 2.3 Ghz
or higher 32/64 GB DDR4-2133 Memory

Dell R7910 Dual 8,10 or 12 Core Intel V3
2.3 Ghz or higher Onboard NIC supported for
ISIS 32 or 64 GB DDR4- 2133 memory

Dell 7910 Dual 8, 10 or 12 core Intel V3 2.3 Ghz
or higher - Onboard NIC supported for ISIS 32
or 64 GB DDR4- 2133 memory

Dell 7810 Dual 8, 10 or 12 core Intel V3 2.3 Ghz
or higher - Onboard NIC supported for ISIS 32
or 64 GB DDR4- 2133 memory

Lenovo P900 Dual 8, 10 or 12 core Intel V3 2.3
Ghz or higher - Onboard NIC supported for ISIS
32 or 64 GB DDR4- 2133 memory

Lenovo P700 Dual 8, 10 or 12 core Intel V3
2.3 Ghz or higher - Onboard NIC supported for
ISIS

32 or 64 GB DDR4- 2133 memory

Lenovo P310 Tower and SFF (Small Form
Factor) Quad Xeon E3- 1245V5 3.5 Ghz
Onboard NIC supported for ISIS

16/32 GB DDR4- 2133 Memory

Dell 3620 quad Xeon E3-1245V5 3.5 Ghz
Onboard NIC supported for ISIS 16/32 GB
DDR4- 2133 Memory
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Nvidia K2200,
K4200, K5200,
M4000, M5000

AMD, W5100,
W7100, W8100

Nvidia K4200,
K5200, M4000,
M5000, M6000

AMD W7100,
W8100

Nvidia K4200,
K5200, M4000,
M5000, M6000

AMD W7100,
W8100

Nvidia K2200,
K4200, K5200,
M4000, M5000

AMD W5100,
W7100, W8100

Nvidia K4200,
K5200, M4000,
M5000, M6000

Nvidia, K2200
K4200, K5200,
M4000, M5000

Nvidia K620,
K1200

K2200

Nvidia K620,
K2200

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Software Only

Software Only



Qualified Hardware and Operating Systems

Qualified PC Hardware

Graphics Card

Supported with

Dell 3420 SFF (Small Form Factor) Quad Xeon Nvidia K620,
E3-1245V5 3.5 Ghz K1200
Onboard NIC supported for ISIS

16/32 GB DDR4- 2133 Memory

Software Only

Dell 5810 4-core or 8 core Intel V3 3.0 Ghz or  Nvidia K2200 Avid Artist DNxIO
higher Avid Artist DNxIQ
AMD W5100
Onboard NIC supported for ISIS Avid Artist DNxIV
16 or 32 GB DDR4- 2133 memory Avid Artist DNxIP
Lenovo P500 4-core or 8 core Intel V3 3.0 Ghz Nvidia K2200 Avid Artist DNxIO
or higher Avid Artist DNxIQ
Onboard NIC supported for ISIS Avid Artist DNxIV
16 or 32 GB DDR4- 2133 memory Avid Artist DNxIP

Qualified PC Notebooks for Avid Media Composer

The following PC Notebooks are qualified with Avid Media Composer. The following applies to
the editing system when running on a laptop:

Qualified PC Notebooks Graphics Cards Supported With

HP Zbook Firefly G8 14” or 15” 1.8Ghz or Nvidia T500 Avid Artist DNxIO
higher 4 core i7 Intel 11th Gen. I . Avid Artist DNxIQ
ntel Iris Xe . .
Avid Artist DNxIV
Avid Artist DNXIP
HP Zbook Fury G7 15” & 17” 2.4Ghz or higher Nvidia T1000,
6 or 8 core 17/19 Xeon 10th Gen T2000,
RTX 3000, 4000,
5000
AMD W5500M
HP Zbook Power G7 15" 2.4 Ghz or higher 6  Nvidia P620, Avid Artist DNxIO
or 8 core 17/19/Xeon 10th Gen T1000 T2000 Avid Artist DNxIQ
16 to 64 GB DDR4-2933 Memory Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
HP Zbook Create G7 15" 2.4 Ghz or higher 6 or Nvidia GeForce Avid Artist DNxIO
8 core 17/19 10th Gen RTX 2070, RTX Av%d Art%st DNxIQ
16 to 32 GB DDR4-2933 Memory HP Zbook 2070 Super RTX Avid Artist DNxIV
Studio G7 15" 2.4 Ghz or higher 6 or 8§ core 2080 Super Avid Artist DNxID
17/19/Xeon 10th Gen Avid Artist DNxIP
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Qualified PC Notebooks

Qualified Hardware and Operating Systems

Graphics Cards

Supported With

HP Zbook Studio G7 15" 2.4 Ghz or higher 6
or 8 core 17/i19/Xeon 10th Gen
16 to 64 GB DDR4-2933 Memory

HP Zbook Firefly 14" or 15" 1.6 Ghz or higher
4 or 6 core i7 10th Gen
16 to 64 GB DDR4-2666 Memory

Lenovo P17 17" 2.4 Ghz or higher 6 or § core
17/19/Xeon 10th gen
16 to 128 GB DDR4-2933 Memory

Lenovo P15 15" 2.4 Ghz or higher 6 or § core
17/19/Xeon 10th gen
16 to 128 GB DDR4-2933 Memory

Lenovo P15v 15" 2.4 Ghz or higher 6 or 8 core
17/19/Xeon 10th gen
16 to 64 GB DDR4-2933 Memory

Lenovo P1 G3 15" 2.4 Ghz or higher 6 or 8 core
17/19/Xeon 10th gen
16 to 64 GB DDR4-2933 Memory

Dell 7750 17" 2.4 Ghz or higher 6 or 8 core
17/19/Xeon 10th gen
16 to 128 GB DDR4-2933 Memory
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Nvidia T1000
T2000 RTX 3000,
4000, 5000

Nvidia P520 Intel
UHD

Nvidia T1000,
T2000 RTX 3000,
4000, 5000

Nvidia T1000,
T2000

RTX 3000, 4000,
5000

Nvidia P620
Intel UHD

Nvidia
T1000, T2000

Nvidia T1000,

RTX 3000, 4000,
5000

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNXIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP



Qualified PC Notebooks

Qualified Hardware and Operating Systems

Graphics Cards

Supported With

Dell 7550 15" 2.4 Ghz or higher 6 or 8 core
17/19/Xeon 10th gen
16 to 128 GB DDR4-2933 Memory

Dell 5750 17" 2.4 Ghz or higher 6 or 8 core
17/19/Xeon 10th gen
16 to 64 GB DDR4-2933 Memory

Dell 5550 15" 2.4 Ghz or higher 6 or 8 core
17/19/Xeon 10th gen
16 to 64 GB DDR4-2933 Memory

Dell 3551 15" 2.4 Ghz or higher 6 or 8 core
17/19 10th gen
16 to 64 GB DDR4-2933 Memory

HP Zbook 17 G6 2.3 Ghz or higher 6 or 8 core
17/19/Xeon
16 to 128 GB DDR4-2667 Memory

HP Zbook 15 G6 2.3 Ghz or higher 6 or 8 core
17/19/Xeon
16 to 128 GB DDR4-2667 Memory

Lenovo P73 17" 2.6 Ghz or higher 6 or § core
17/19/Xeon
16 to 128 GB DDR4-2667 Memory
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Nvidia T1000,
T2000

RTX 3000, 4000

Nvidia T2000,
RTX3000

Nvidia T1000,
T2000

Nvidia P620

Nvidia RTX 3000,
4000, 5000

Nvidia T1000
T2000 RTX3000

Nvidia T2000,

RTX
3000,4000,5000

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNXIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP



Qualified PC Notebooks

Qualified Hardware and Operating Systems

Graphics Cards

Supported With

Lenovo P1 G2 15" 2.6 Ghz or higher 6 core i7

16 to 64 GB DDR4-2667 Memory

Lenovo P53 15" 2.3 Ghz or higher 6 or 8§ core

17/19/Xeon
16 to 128 GB DDR4-2667 Memory

Dell 7740 17" 2.6 Ghz or higher 6 or 8 core
17/19/Xeon
16 to 128 GB DDR4-2667 Memory

Dell 7540 15" 2.6 Ghz or higher 6 or 8 core
17/19/Xeon
16 to 128 GB DDR4-2667 Memory

Dell 5540 15" 2.3 Ghz or higher 6 or 8 core
17/19/Xeon
16 to 64 GB DDR4-2667 Memory

Dell 3541 15" 2.3 Ghz or higher 6 or 8 core
17/19/Xeon
16 to 32 GB DDR4-2667 Memory

HP Zbook Studio G5 5 2.6 Ghz or higher six
core i7/Xeon E3 Ultrabook

16 to 64GB 2667Mhz DDR4 Memory
Dream Color option

HP Thunderbolt dock G2
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Nvidia T1000,
T2000

Nvidia T1000,
T2000,

RTX 3000, 4000

Nvidia RTX 3000,
4000, 5000

AMD WX7130

Nvidia T1000
T2000 RTX3000

Nvidia T1000,
T2000

Nvidia P620

Nvidia P1000,
P2000

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNXIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP



Qualified PC Notebooks

Qualified Hardware and Operating Systems

Graphics Cards Supported With

Dell 5530 15" 2.6Ghz or higher 6 core i7/Xeon
E3

Thin and light

16 to 32 GB 2667Mhz DDR4 Memory

USB 3.0 to Ethernet required for Avid NEXIS
Connectivity

Lenovo P1 15” 2.6 Ghz or higher six core
i7/Xeon E3 Thin and Light
16 to 64 GB 2667Mhz DDR4 Memory

HP Zbook 17" G5 2.6 Ghz or higher six core
i7/Xeon E3
16 to 64 GB 2667Mhz DDR4 Memory

Dell 7730 17" 2.6Ghz or higher 6 core i7/Xeon
E3
16 to 64 GB 2667Mhz DDR4 Memory

Lenovo P72 2.6 Ghz or higher six core i7/Xeon
E3
16 to 64 GB 2667Mhz DDR4 Memory

HP Zbook 15" G5 2.6 Ghz or higher six core
i7/Xeon E3

16 to 64 GB 2667Mhz DDR4 Memory
Dreamcolor option

HP Zbook 15V G5 2.6 Ghz or higher six core
i7/Xeon E3
HP Thunderbolt dock G2
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NvidiaP1000
P2000

Nvidia P1000

Nvidia P3200,
P4200, P5200
AMD WX4170

NvidiaP3200
P4200 P5200
AMD WX4170

Nvidia P3200,
P4200, P5200

Nvidia P1000,
P2000

AMD WX4150

Nvidia P600

Avid Artist DNxXIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP



Qualified PC Notebooks

Qualified Hardware and Operating Systems

Graphics Cards

Supported With

Dell 7530 15" 2.6Ghz or higher 6 core i7/Xeon
E316 to 64 GB 2667Mhz DDR4 Memory

Lenovo P52 2.6 Ghz or higher six core i7/Xeon
E3
16 to 64 GB 2667Mhz DDR4 Memory

HP Zbook 17" G4 2.8 Ghz or higher quad core
i7/Xeon E3

HP Thunderbolt dock G2

16 to 64 GB DDR4-2400 Memory

HP Zbook 15" G4 2.8 Ghz or higher quad core
i7/Xeon E3

HP Thunderbolt dock G2

16 to 64 GB DDR4-2400 Memory

HP Zbook Studio Ultrabook G4 2.8 Ghz or
higher quad core i7/Xeon E3

HP Thunderbolt dock G2

16 to 64 GB DDR4-2400 Memory

Dell 7720 17" 2.6 Ghz or higher quad core
17/Xeon E3 1920x1080 or 3840x2160 - 16 to
64 GB DDR4-2400 Memory

Dell 7520 15" 2.6 Ghz or higher quad core
17/Xeon E3 1920x1080 or 3840x2160 - 16 to
64 GB 2400Mhz DDR4 Memory
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NvidiaP1000
P2000
AMD WX4150

Nvidia P1000,
P2000

Nvidia
P3000
P4000
P5000
AMD
WX4170

Nvidia

M620

M1200

M2200

AMD WX4150

Nvidia
M1200

Nvidia P3000,
P4000, P5000

AMD Radeon
WX4150, WX7100

Nvidia M1200,
M2200

AMD Radeon
WX4130, WX4150

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNXIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP



Qualified Hardware and Operating Systems

Qualified PC Notebooks Graphics Cards Supported With
Dell 5520 15" 2.8 Ghz or higher quad core Nvidia M1200 Avid Artist DNxIO
i7/Xeon E3 1920x1080 or 3840x2160 - 16 to Avid Artist DNxIQ
32 GB 2400Mhz DDR4 Memory Avid Artist DNxIV
Avid Artist DNXID

Avid Artist DNXIP

Dell 3520 15" 2.8 Ghz or higher quad core Nvidia Avid Artist DNxIO
i7/Xeon E3 1920x1080 - 16 to 32 GB 2400Mhz M620 Avid Artist DNXIQ
DDR4 Memory Avid Artist DNxIV
Avid Artist DNXID

Avid Artist DNxIP

Lenovo P51 2.6 Ghz or higher quad core Nvidia M1200, Avid Artist DNxIO
i7/Xeon E3 M2200 Avid Artist DNXIQ
16 to 64 GB 2400Mhz DDR4 Memory Avid Artist DNxIV
Avid Artist DNxID

Avid Artist DNxIP

Lenovo P71 2.6 Ghz or higher quad core Nvidia P3000, Avid Artist DNxIO
i7/Xeon E3 P4000, P5000 Avid Artist DNXIQ
16 to 64 GB 2400Mhz DDR4 Memory Avid Artist DNXIV
Avid Artist DNxID

Avid Artist DNxIP

HP Zbook 15" G3 2.6 Ghz or higher Quad core Nvidia M1000M,  Avid Artist DNXIO
i7/Xeon E3 1920x1080 or 3840x2160- 16 to 64 Avid Artist DNXIQ

M2000M, M600M . .

GB 2133Mhz DDR4 Memory, thunderbolt 3 Avid Artist DNxIV
AMD, W5170M  Avid Artist DNxID

Avid Artist DNxIP

HP Zbook 17" G3 2.7Ghz or higher quad core  Nvidia M3000M,  Avid Artist DNxIO
M4000M, M5000M  Avid Artist DNxIQ

i7/Xeon E3 Avid Artist DNxI
AMD W7170M vid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Dell 7710 17" 2.7 Ghz quad core i7 or 2.9 Ghz Nvidia M1000M,  Avid Artist DNXIO
Xeon E3 1920x1080 or 3840x2160 - 16/32 GB  M2000M Avid Artist DNXIQ
2133Mhz DDR4L Memory AMD W7170M Av%d Art¥st DNxIV
Avid Artist DNxID
Avid Artist DNxIP

32



Qualified Hardware and Operating Systems

Qualified PC Notebooks Graphics Cards Supported With
Dell 7510 15" 2.5 Ghz and higher quad core i7 Nvidia M1000M,  Avid Artist DNxIO
1920x1080 or 3200x1800 - 16/32 GB 2133Mhz M2000M Avid Artist DNxIQ
DDR4L Memory AMD W5170M Av¥d Art%st DNxIV
Avid Artist DNxID
Avid Artist DNXIP
Dell 5510 15" 2.3 Ghz and higher quad core i7 Nvidia M1000M Avid Artist DNxIO
1920x1080 or 3840x2160 - 8/16 GB 2133Mhz Avid Artist DNXIQ
DDR4L Memory USB-C Avid Artist DNXIV
Avid Artist DNxID
Avid Artist DNxIP
Dell 3510 15" 2.3 Ghz and higher quad core i7 AMD W5130M Avid Artist DNxIO
1920x1080 - 16 GB 2133Mhz DDR4L Avid Artist DNXIQ
Memory Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Lenovo P70 2.6 Ghz or higher quad core Nvidia M3000M,  Avid Artist DNxIO
i7/Xeon E3 M4000M, M5000M Avid Artist DNxIQ
1920x1080 or 3840x2160 - 16 to 64 GB Avid Artist DNXIV
2133Mhz DDR4, Memory, thunderbolt 3 Avid Artist DNxID
Lenovo P50 2.6 Ghz or higher quad core Nvidia M1000M,  Avid Artist DNxIO
i7/Xeon E3 1920x1080 or 3840x2160 - 16 to 64 M2000M Avid Artist DNXIQ
GB 2133Mhz DDR4 Memory, thunderbolt 3 Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Qualified Macintosh Workstations for Avid Media Composer
The following Macintosh Workstations are qualified with the Avid Media Composer.

Avid Artist DNxIV requires a Thunderbolt 2 or 3 card. See details here.

Qualified Macintosh Hardware Graphics Cards Supported With
iMac Retina 5K 27" 3.8 Ghz 8-core Intel i7 AMD Radeon Pro Avid Artist DNxIO
3.6 Ghz 10-core Intel i9 5500XT, 5700, Avid Artist DNxIQ
Aug 2020 5700XT Avid Artist DNxIV
16 to 128 GB 2666 Mhz DDR4 Avid Artist DNXID

Avid Artist DNXIP
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http://avid.force.com/pkb/articles/en_US/Compatibility/DX-DNxIO-connection-chart

Qualified Macintosh Hardware

Qualified Hardware and Operating Systems

Graphics Cards

Supported With

Mac Pro 2019 AMD Radeon Pro Avid Artist DNxIO
3.5 Ghz 8 core, 3.3 Ghz 12 core, 3.2 Ghz 16 580X, W5700X, Pro  Avid Artist DNxIQ
core, 2.7 Ghz 24 core, 2.5 Ghz 28 core Vegall Avid Artist DNxIV
48 to 192GB 2933Mhz DDR4 Memory Avid Artist DNxID
Avid Artist DNxIP
Dual 10Gb Ethernet RJ45
iMac Retina 5K 27” 3.6 GHz 8-core Intel 19 AMD Radeon Pro Avid Artist DNxIO
16 to 64GB 2666MHz DDR4 575x%, 580x, Vega 48  Avid Artist DNxIQ
Avid Artist DNxIV
March 2019 Avid Artist DNxID
Avid Artist DNxIP
iMac Retina 4K 21.5” 3.2 GHz 6-core Intel i7 AMD Radeon Pro Avid Artist DNxIO
16 to 32 GB 2666 MH DDR4 560x Vega 20 Avid Artist DNXIQ
Avid Artist DNxIV
March 2019 Avid Artist DNxID
Avid Artist DNxIP
Mac mini 3.2 Ghz 6- core Intel 17 Intel UHD 630 Avid Artist DNxIO
16 to 64 GB 2666 Mhz DDR4 Memory Avid Artist DNXIQ
Avid Artist DNxIV
Late 2018 Avid Artist DNxID
Avid Artist DNxIP

iMac Pro 5K 27" 3.2 Ghz i7 § core Radeon Pro Vega 56, Avid Artist DNxIO

3.0 Ghz i7 10 core 64 Avid Artist DNxIQ
2.5 Ghz 17 14 core Avid Artist DNxIV
2.3 Ghz i7 18 core Avid Artist DNxID

Avid Artist DNxIP

Late 2017 - 32 to 128GB 2666 Mhz DDR4
NOTE: 10Gb Ethernect requires Avid NEXIS
Pro client v2018.3.

iMac Retina SK 27" 4.2 Ghz i7 Quad core ~ Radeon Pro 570, 575, Avid Artist DNxIO
. 580 Avid Artist DNXIQ
Mid 2017 - 16 to 64 GB 2400 Mhz DDR4 Avid Artist DNxIV
Avid Artist DNXID

Avid Artist DNXIP

iMac Retina 4K 21.5" 3.6 Ghz i7 Quad core Radeon Pro 555, 560 Avid Artist DNxIO

. Avid Artist DNxIQ
Mid 2017 - 16 to 32 GB 2400Mhz DDR4 i Artt DNATY
Avid Artist DNxID

Avid Artist DNxIP
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Qualified Macintosh Hardware

Qualified Hardware and Operating Systems

Graphics Cards

Supported With

iMac Retina 5K 27" 4.0 Ghz i7 Quad core
Late 2015 - 16/32 GB 1867Mhz DDR3

iMac Retina 4K 21.5" 3.3 Ghz i7 Quad core
Late 2015 - 16/32 GB 1867Mhz DDR3

Mac Pro 3.5 Ghz 6-core, 3.0 Ghz 8-core, or
2.7 Ghz 12-core Ivy Bridge CPU
Late 2013

16, 32 or 64 GB DDR3-1866Mhz
ECCmemory (4 DIMMs required) Sonnet
and Magma Thunderbolt 2 Expansion chassis
supported

Radeon M390, M395,

M395X

Intel Iris Pro 6200

Dual AMD FirePro
D300, D500, D700

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNXIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Qualified Macintosh Notebooks for Media Composer

The following Macintosh notebooks are qualified with the current editing applications. The

following applies to the editing system when running on a laptop.

*  HD Capture on Macintosh notebooks is not supported

*  Playback in full quality 10 bit mode is not supported

Qualified Macintosh Notebook

Graphics Cards

Supported With

MacBook Pro 13" May 2020

2.3 Ghz Intel i7 4-core

10th gen Intel

16 to 32 GB 3733Mhz LPDDR4X

MacBook Pro 16"2019 2.6 Ghz 17 6-core or
2.3, 2.4 Ghz i9 8-core Thunderbolt 3
16 to 64GB 2666Mhz DDR4 Memory

Touch Bar not used by Media Composer
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Intel IRIS plus

AMD Radeon Pro
5300M, 5500M

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP



Qualified Macintosh Notebook

Qualified Hardware and Operating Systems

Graphics Cards

Supported With

MacBook Pro 13" 2.8 Ghz 4-core Intel core 17
- Mid 2019
16 GB 2133Mhz LPDDR3

MacBook Pro 15" 2.2 Ghz and higher 17/i9 six
core Mid 2018 - Touch Bar & Thunderbolt 3

Touch Bar not used by Media Composer

MacBook Pro 13" 2.7 Ghz quad core Intel core
17 Mid 2018 - Touch Bar & Thunderbolt 3
16 GB 2133Mhz LPDDR3 Memory

Touch Bar not used by Media Composer

MacBook Pro 15" 2.8 Ghz and higher i7 quad
core Mid 2017 - Touch Bar & Thunderbolt 3
16 GB 2133Mhz

LPDDR3 Memory
Touch Bar not used by Media Composer

MacBook Pro 15" 2.6 Ghz and higher i7 quad
core Late 2016 - Touch Bar & Thunderbolt 3
16 GB 2133Mhz DDR4 Memory

Touch Bar not used by Media Composer

Intel Iris Plus 655

UHD630 AMD
Radeon Pro 555X,
560X

Intel Iris Plus 655

HD630
AMD
Radeon

Pro 555, 560

HD530
AMD
Radeon

450, 455, 460

Avid Artist DNXIO
Avid Artist DNxIQ
Avid Artist DNXIV
Avid Artist DNxID
Avid Artist DNXIP

Avid Artist DNxXIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
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Feature Performance

Feature Performance

A number of features in this editing application are processor-intensive. As a result, you might
experience problems if you are working on an older system. The following chart shows the
hardware that Avid has successfully qualified when using these features. For a list of the
qualified systems, see Qualified Workstations and Laptops.

Feature Description Recommended System

16K projects 96GB RAM minimum 48 Core Intel CPU systems with Nvidia
RTX graphics

Editing High Resolution, 64 GB RAM minimum, 96 GB HP Z8, 76,

High Frame Rate XAVC-I recommended Lenovo P920, P720, P620 systems

Media (UHD/4k in Dell 7920, Dell 7820

59.94p)

e Dual gold 6254 3.1 Ghz turbo to 4.0
Ghz 18-core (72 with HT)

» Dual Xeon Gold 6154 3.0 Ghz, turbo
up to 3.7 Ghz 18-core (72 cores with
Hyperthreading)

+ AMD WX-7100

* Nvidia RTX 5000, RTX 6000, AMD
WX9100

Storage: 10Gb Ethernet Avid NEXIS

4 streams of media and
color adapters

1080p/50 XAVC Long 16 GB RAM minimum Qualified PC Dual 6 Core or higher

Baseband Capture Qualified Mac Pro 6 core or higher, 12
core with Hyperthreading
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Feature Performance

Feature

Description

Recommended System

Editing High Resolution,
High Frame Rate DNxHR
Media (UHD/4k in
59.94p)

Editing High Resolution
Media (Higher than 2K+)

DMF and Background
Transcode, Background
Render

Media Composer | Cloud

J2K Capture

32GB Min, 64 GB recommended

16 GB RAM minimum

32 GB RAM recommended

16 GB RAM minimum. 24 GB or
higher recommended depending
upon system model.
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HP 78, 76,

Lenovo P920, P720, P620 systems
HP 7840

HP 7640/2620

Dell 7920/7910

Dell 7820/7810

Lenovo P910/P900/

Lenovo P710/P700

* NVIDIA RTX 5000, 6000, AMD
WX9100

+ NVIDIA P5000, M5000 or K5200
and AMD WX-7100
PClIe Gen3 Gfx card (recommended)

Mac Pro

* 12 core (24 with Hyperthreading)
3 GHz

* Dual AMD FirePro 500/700 Graphics
card

Storage: 10Gb Ethernet Avid NEXIS

Qualified PC Dual 6 Core or higher

Qualified Mac Pro 6 core or higher, 12
core with Hyperthreading

Qualified PC Dual 6 Core or higher

Qualified Mac Pro 6 core or higher, 12
core with Hyperthreading

17 Quad core or higher with
Hyperthreading

Qualified PC Dual 6 Core or higher

Qualified Mac Pro 6 core or higher, 12
core with Hyperthreading



Feature Performance

Feature

Description

Recommended System

XDCAM Long GOP
9-way MultiCam with
high stream count
sequences

Stereoscopic 3D

XDCAM HDS50 Capture

HD RGB 4444
Apple ProRes 4444
DNxHD 4444

AMA (QuickTime)

AMA (RED)

AVCl-Intra Capture

Avid recommends 16 GB RAM

For optimal performance with
Stereoscopic 3D, use these higher
performance systems. Avid
recommends a minimum of 16GB
RAM when using Stereoscopic
3D.

HD RGB capture requires a high
end workstation.

AMA is a processor intensive
operation. Lower end platforms
may not offer optimum
performance. Highly compressed
codecs such as H.264 will exhibit
minimal real-time performance.

AMA is a processor intensive
operation. Older platforms may
not offer optimum performance.
you will get better performance
with higher end workstations.

AVC-Intra capture with software
codecs is supported.
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Qualified PC Dual 6 Core or higher

Qualified Mac Pro 6 core or higher, 12
core with Hyperthreading

Storage: 10Gb Ethernet ISIS

Qualified PC Dual 6 Core or higher

Qualified Mac Pro 6 core or higher, 12
core with Hyperthreading

Qualified systems

Qualified PC Dual 6 Core or higher

Qualified Mac Pro 6 core or higher, 12
core with Hyperthreading

Storage: 10Gb Ethernet ISIS

Recommendation of qualified systems
depends on your planned use of this
feature. Heavy usage of highly
compressed codecs requires the high end
systems. (Dual 6 Core or Dual 8 Core
systems)

Qualified Xeon Workstations

NOTE: RED plug-in uses the Graphics
Processor. Better performance with high
performance graphics cards.

24 core and higher Windows systems
only.



Avid Artist I/O Device Compatibility

Feature

Description

Recommended System

AVCI-Intra

AVC-Intra(AVC-I) is a high 4-Way MultiCam Playback
quality, low bit-rate HD codec and Dual Quad Core, Dual 6 Core or Dual 8

is very CPU intensive.

Core Systems
Four Stream Playback:

Dual Quad Core, Dual 6 Core or Dual 8
Core Systems

AMA Workflows: Dual Quad, Dual 6 or
Dual 8 core systems

Avid Artist I/0 Device Compatibility

The following table shows the minimum version Media Composer supported with the Avid

Artist I/O devices.

You must download the appropriate Avid Artist software from your Avid Master Account.

Device

Minimum supported version Media
Composer

Avid Artist | DNXIO
Avid Artist | DNxIQ
Avid Artist | DNXIV
Avid Artist | DNxIP

Avid Artist | DNxID

Media Composer v8.4.1 and higher
Media Composerv8.8.3 and higher
Media Composer v8.10 and higher
Media Composer v2018.8

Media Composer v2018.9
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https://my.avid.com/account/orientation

Compatibility Chart

Compatibility Chart

The following table lists the NVIDIA® driver, QuickTime®, Windows Media™, shared storage,
Sony® XDCAM™, Panasonic® P2, and Avid Artist Series versions that were qualified with the
Avid editing applications. You can also refer to Documentation and version matrix.

IMPORTANT: For information on third party support (for example, Sorenson, Boris,

etc) see the third party’s web site.

Item Versions

Comments

QuickTime Support  v7.7.9 (Windows)
v10.x, (v7.x legacy) (Macintosh)

Avid Interplay See Knowledge Base article on
Support compatibility.

NVIDIA Driver v461.72

Support

Shared Storage Avid NEXIS and Avid ISIS®.
Support

Sony XDCAM driver v2.13 (XDCAM Transfer for
Macintosh)

Windows FAM v2.3.2 and VFAM
v5.0.2
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Note: QuickTime v10X does not include
QuickTime Pro options.

Note: QuickTime is not supported with
Windows 10.

IMPORTANT: The Avid Interplay
components that get installed on the
editing application must be updated to
the Avid Interplay version that is released
with the editing application. These
include the Media Indexer, Interplay
Access, Interplay Framework, Interplay
Transfer Client and ProEncode Client.
The Avid Interplay Server components
can remain on the previous releases listed
as supported. For details, see the “Avid
Editing Application Compatibility with
Interplay Releases” doc on the
Knowledge Base.

See “Setting up the NVIDIA Card” on
page 44.

For setting up the driver for stereoscopic,
see the NVIDIA setup info in the
Stereoscopic 3D Workflow Guide.

See “Shared Storage Support” on
page 45.

The VFAM firmware version for
PDW-UI is 2.600.

The PDW-U2 is 2.810.

The driver can be downloaded from
Sony's website http://esupport.sony.com/.


http://avid.force.com/pkb/articles/en_US/compatibility/Avid-Video-Compatibility-Charts
http://esupport.sony.com/
http://avid.force.com/pkb/articles/en_US/compatibility/en267087

Avid Editing Application Compatibility with Pro Tools

Item Versions Comments

Panasonic P2 drive (Macintosh) v3.1.7 There is currently no P2 writeback
(Windows) v2.24 support for Macintosh clients.

Avid Artist Series EuControl software v3.4 See the User’s Guide for information on

(Euphonix) Artist Series Color setup information.

Avid Editing Application Compatibility with
Pro Tools

General Co-Installation Notes:

Install Pro Tools first and then Media Composer.

You must uninstall all older versions of Media Composer or Pro Tools before installing
newer versions.

Co-install does not support both applications launched simultaneously.

When you uninstall Pro Tools, choose to uninstall just the application and not the audio
drivers or the editing application no longer sees the devices. On a Macintosh Pro Tools 10
system, this is named the “Safe Uninstall.” On a Macintosh Pro Tools 11 system no
uninstallation is required. On a Windows Pro Tools 10 or 11 system, you must select the first
uninstall option - “Pro Tools Only” - which is not selected by default.

If you run into any issues, uninstall both applications and reinstall Pro Tools first, and then
reinstall your editing application.

Media Composer v5.0 and later and Pro Tools v8.0.3 and later do not include support for the
Original Mbox. If you want to use the Original Mbox, you should use Media Composer v4.x
and Pro Tools v8.0.1 instead.

If you want to install your Avid editing application on a system with the Pro Tools Avid
Video Engine installed, you must use one of the following configurations:

- Media Composer v5.5/NewsCutter v9.5 and later with Pro Tools v9.0 or later.

- Media Composer v5.0.x/NewsCutter v9.0.x with Pro Tools v8.5 or earlier.
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External Controllers

External Controllers

Your Avid editing application supports the following external fader controllers or mixers for
automation gain and pan recording or as control surfaces:

*  Digi 002 (Windows only)
+ Command|8

*  Avid Artist Control

o Avid Artist Mix

*  Avid Artist Transport

*  Avid Artist Color

External controllers or mixers are optional. They are not required for you to perform automation
gain or pan recording on an Avid editing system.

The following table compares Avid external controllers and mixers.

Avid

Digi 002 Command| Artist Avid Avid Artist  Avid Artist
Feature (MC only) 8 Control Artist Mix Transport Color
Control surface Yes Yes Yes Yes Yes
for transport (transport
controls and only, no soft
other functions keys)
Provides audio Yes No No No No
play, input, and
output
Record Yes Yes Yes Yes No
automation
gain
Record Yes Yes Yes Yes No
automation pan
Flying faders  Yes (8) Yes (8) Yes (4) Yes (8) No
Touch-sensitive Yes Yes Yes Yes No
faders
Touch-sensitive No No Yes Yes No
panners
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Setting up the NVIDIA Card

Avid

Digi 002 Command| Artist Avid Avid Artist  Avid Artist
Feature (MC only) 8 Control Artist Mix Transport Color
Solo/mute Yes Yes Yes Yes No
Supports audio No? No No No No
mixing
Latch mode Yes Yes Yes Yes No
(also known as
Snap mode)
Number of 1024 1024 1024 1024 Not applicable

steps of fader
accuracy

a. The Digi 002 can be used as a standalone audio mixer but not at the same time as it is being used as an automation gain or
automation pan controller or control surface.

For more information on using these external fader controllers or mixers, see “Recording

Automation Gain or Automation Pan Information” in the Help.

Setting up the NVIDIA Card

To set up the NVIDIA card, you must make sure you have the correct display driver version
(install the display driver if necessary, and set the correct display settings. See the “Compatibility
Chart” on page 41 for information on the supported driver(s).

Prior to setting up the NVIDIA card, check to make sure you have the correct display driver
version. If you do not have the correct NVIDIA driver, you can install it from the Nvidia website

- Nvidia.com.

To check the NVIDIA display driver version:

1. Right-click the Desktop and select NVIDIA Control Panel. You can also open the Windows
Control Panel and double-click the NVIDIA Control Panel icon.

2. Click System Information at the bottom left corner of the NVIDIA Control Panel.

The version number is listed in the Graphics card information section on the ForceWare

version line.
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Shared Storage Support

To install the NVIDIA display driver:
1. Download the applicable Nvidia driver from the Nvidia website - Nvidia.com.
2. Double-click the file for the applicable driver.

3. Follow the on-screen instructions, and then restart your system.

To setup multiple displays:
1. Right-click the Desktop, and select Nvidia Control Panel.
2. In the settings window in the left of the window, click Set up multiple displays.

3. Select or deselect the desired monitors listed.

To set the Driver for Avid Editing Environments
1. Right-click the Desktop, and select Nvidia Control Panel.
Select the Desktop menu selection in the Control Panel menu bar.
Enable Desktop > Video Editing Mode.
Click Manage 3D Settings.
Click the Global Setting tab.
Under Global presets, select Base Profile.
Scroll to locate the Power Management Mode. Select Prefer maximum performance.
Click Apply.

® N kv

Reboot after installing the Nvidia software even if you are not prompted to do so.
Never use the Windows “roll back driver” feature on the Nvidia driver. The driver version must
match the rest of the components the Nvidia installer installs.

Shared Storage Support

For information on Shared Storage Support, see the Avid NEXIS and Avid ISIS tables in the
following document:

http://resources.avid.com/SupportFiles/Attachments/MediaCentral_Compatibility_Matrix.pdf
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Shared Storage Support

Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may
only be used in accordance with the license agreement.

This product may be protected by one or more U.S. and non-U.S patents. Details are available at www.avid.com/patents.

No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, including
photocopying and recording, for any purpose without the express written permission of Avid Technology, Inc.

Copyright © 2021 Avid Technology, Inc. and its licensors. All rights reserved.
Portions © Copyright 2003-2007 of MOG Solutions.

Attn. Government User(s). Restricted Rights Legend

U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a
unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the
License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks

Avid, the Avid Logo, Avid Everywhere, Avid DNXHD, Avid DNXHR, Avid Nexis, AirSpeed, Eleven, EUCON, Interplay, INEWS, ISIS,
Mbox, MediaCentral, Media Composer, NewsCutter, Pro Tools, ProSet and RealSet, Maestro, PlayMaker, Sibelius, Symphony, and
all related product names and logos, are registered or unregistered trademarks of Avid Technology, Inc. in the United States and/or
other countries. The Interplay name is used with the permission of the Interplay Entertainment Corp. which bears no responsibility
for Avid products. All other trademarks are the property of their respective owners. For a full list of Avid trademarks, see:
http://www.avid.com/US/about-avid/legal-notices/trademarks.

Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or
other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. Windows

is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries. All other
trademarks contained herein are the property of their respective owners.
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